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Section 1: Working With Outline

Overview

Outline view offers these advantages:

. In Outline view you see only the presentation text — you don'’t see graphs, tables,
or the design elements of the presentation, such as the colour scheme and the
background design. This way you can concentrate on the content of the
presentation — what it says — without being side tracked by its appearance.

. In Outline view you can easily enter the list of main topics of the show. Entering
the topics generates all the slides you need because each main topic becomes
the title of a slide.

J It is easy to rearrange the topics in Outline view, therefore changing the order in
which you will address issues in the show.

Switching to Outline View

To change to Outline view, click on the Outline tab at the left of the screen.

. " . 7 ; = =)
& Microsoft PowerPaint - [New Intro Exercise. ppt] ¢ Mirophone #ATooks 5 Hendwniing mmwriingPed B 2 [=|[2)X]
i) Fle Edt view Insert Format  Tools  SldeShow  Window  Help Type aquestionforhelp |+ X
NN REN SIS NEY A Y R

: Tahoma v32+-|BIHEI|§

°™ |/ Outline {_Slides
a

(/e cwerpaint 2003
per

22| Agenda

+ Designs, Mdters & Backgrounds

+ Bullet Slides, T

« Pictures

+ Drawings

- Tables

« Graphs & Organisation Charts

+ animating & Rurning the show

31| Designs & Masters E PowerPoint 2003

+ PowerPoint comes with design Templates = =

« You can also create your own designs 5

+ & Presentation Design is a combination of Colours,
Backgrounds & Masters

+ Regardless of if you are creating your own design or
applying a PowerPoint Design, don't format as you go
- let e Design do this for you

il 1 s |4

4
L

Change the size of
the pane here

4| Bullets
+ The majority of slides in a presentation are often
bullet slides
« Five levels of bullets are available
+ Don't use too many levels on the same slide
« & maximurn of two levels are recommended
5|1 Bullet Levels
= Major Heading Click to add notes
+ Sub Heading
+ Sub Heading
=R =
Soaw-[is] aosopes- N ND O A AG BER-L-A-===a 3]

Slide 1 of 18 Ocean

v

Entering the Main Topics

When you change into Outline view you enter a title for the presentation and a list of
the topics you plan to discuss. The title and topics will become your preliminary slide
titles. Don’t worry about getting the order exactly right, you can always rearrange them
later.

To enter topics for your presentation, follow these steps:

1. Type the presentation title and press Enter.

2. Type the first topic and press Enter.

© Senan Solutions Page 1



3.

Type the next topic and press Enter, carrying on typing the topics for each

successive slide pressing Enter after each one, except the last.

1 2 Presentation to the Board of Directors
23 Proposed New Product

330 Description

42 Benefit to the Product Range

52 Pricing

6 (2 Target Audience

70 Advertising

50 Summary|

Adding Bulleted Iltems

After entering a list of items you are ready to add the supporting statements. To add
bulleted items under a topic, follow these steps.

1.

2.

Move the insertion point to the end of the topic that needs the bulleted items.

Press Enter to create a new line. PowerPoint adds a slide icon and renumbers

the existing topics.

13 Presentation to the Board of Directors
23 Proposed New Product

30 Description

= Drganic Fhubarh
= Grown by local farmers
» Full of flavou|

40 Benefit to the Product Range
5O Pricing

60 Target Audience

73 Advertizing

50 Summary

4

Click the Demote button on the Outlining toolbar or press the TAB key to move

the insertion point one level to the right. Type the first bulleted item. Press
Enter to start another bulleted item. Carry on typing each bulleted item

pressing enter at the end of each one except the last one.

© Senan Solutions
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Promote

&
- Demote

If you add bulleted items below a topic on your outline and you want to add a new topic,
press ENTER at the end of the last bulleted item and then click the Promote button on
the outline toolbar or press Shift+Tab to move the insertion point one level to the left.

You can have five levels of items on a slide. Each level is indented from the previous
one and has its own bullet style.

Reorganising Text in Outline View

You can really start to appreciate the power of Outline view when you have to start
reorganising the text of your presentation.

Selecting Topics and Bulleted Items

Before you can reorganise the presentation you must select the element you want to
work with. See the table below for information on selecting:

To select Do This

An entire topic Click the slide number
or
Click the slide icon
or

Triple click the topic text

Multiple Slides Hold down the Shift key while click each slides icon.
Bulleted ltem Click in the space to the left of the bullet
or

Triple click a word in the bulleted item

Reordering Topics and Bulleted Items

After you select a topic or a bulleted item, you can move it up or down in the outline to
enhance the logic of your presentation.

To move an entire topic, follow these steps:

1. Point to the slide icon for the selected topic.

2. Hold down the mouse button and drag up or down. The pointer becomes a
double-headed arrow and a horizontal line indicates where the topic will drop

when you release the mouse button.

3. Release the mouse item. The topic and its bulleted items move to the new
position.

You can also use the Move Up and Move Down arrows on the Outline Toolbar to move
a topic.

© Senan Solutions Page 3



To move a bulleted item up or down:

Move Up
L Move Down
1. Select the bulleted item.
2. Click the Move Up or Move Down button until the bulleted item is where you
want it.

Hiding and Revealing Detail

Sometimes you need to skip back to the big picture when working on a presentation. If

you are displaying the whole presentation sometimes the sheer size of it can muddle

the big themes. By collapsing bulleted items you can temporarily hide them from view

and show only the larger topics. To redisplay the bulleted items you expand them.
Collapse

e Expand

To collapse bulleted items under a topic:

1. Click anywhere within the topic and then click the Collapse button on the
Outline toolbar.

To expand bulleted items under a topic:

2. Click anywhere within the topic and then click the Expand button on the
Outline toolbar.

To quickly collapse and expand all bulleted items in the presentation, click the Collapse
All, or Expand all icons on the Outline toolbar.

= Collapse All

Expand All
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Importing Outlines

You can create a presentation outline in Microsoft Word and then easily export the
outline to PowerPoint.

Because PowerPoint imports Word outlines so easily, anyone can create an entire text

presentation in Word and hand the file over to you. You can then import the outline,
give the presentation a distinctive look, and generate slides in no time.

To import a Word outline:

1. Open the outline in Word.
2. From Word’s file menu choose Send To.
3. From the Send to submenu choose Microsoft Office PowerPoint. Word

opens PowerPoint if necessary, opens a new presentation in Outline view, and
exports the outline to PowerPoint.

To export a PowerPoint outline to Word:

1. Open the outline in PowerPoint.
2. From PowerPoint’s File menu choose Send To.
3. From the Send to submenu choose Microsoft Office Word. Choose the

layout you require and choose OK.

Outline Toolbar

When in outline view, the Outline Toolbar will be displayed on the left of the screen.
The toolbar enables slides to be re-ordered, titles just to be displayed for the slides and
formatting to be displayed.

Promote
Demote

Move up
Move Down

I |« & | & 4

Collapse
Expand

| +

Collapse All
Expand All

Summary Slide

Show Formatting
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Section 2: Creating a Design Template

Applying a Different Template

The easiest — and most sweeping — step you can take when you want to change the
look of a presentation is to apply a different template. Changing the template makes a
wholesale change to just about every aspect of the presentation’s appearance.

The template is the most powerful of the central controls. Among other things,
changing the template:

o Changes the colour scheme that controls the colours used in the presentation.

o Changes the title master and the slide master, which in turn changes the
background design and default text formatting.

Professional artists created the templates that come with PowerPoint so they produce
polished attractive presentations. You may soon find, however, that you want to create
your own templates in your company’s corporate style.

Creating a New Template

To create a custom look for future presentations, you can create your own template
based on the changes you have made to a presentation’s colour scheme and its title
and slide masters. The easiest way to create a template is to model it on an existing
one.

To create a template, follow these steps:

1. Open or create a presentation that you want to use as the basis for a template.
2. Make any changes to the presentation that you want to save in the new
template:

v' Changing the Colour Scheme
v’ Edit the Title Master or Slide Master
v' Change the fonts and text formatting for the slide titles and bulleted text.

v' Place any graphic objects on the Master that you wish to appear on each

slide.
3. From the File menu, choose Save As.
4. Locate the folder in which you want to save the template.
5. In the Save As. type box, select Desigh Template.
6. In the File name edit box, type a name for the template and then click Save.
7. Design Templates are saved with the extension *.pot

© Senan Solutions Page 6



Changing the Colour Scheme

Every template you apply contains a colour scheme that provides the various parts of a
presentation with a co-ordinated set of eight default colours. The most distinctive part

of the presentation is the background, so the first colour in the scheme is the
background colour. The other seven colours tastefully match the background colour
and are applied to text, charts and other objects that appear against the background.

Selecting a Standard Colour Scheme

The easiest way to change the colour scheme of a
presentation is to select one of PowerPoint’s standard
colour schemes which were created by professional
artists.

1. To select a predefined colour scheme:
2. Click Color Schemes in the Slide Design task pane.
3. Select a color scheme from those displayed in the task

pane.

If you previously applied a colour to a specific element in
your presentation, that element will not be affected by the
new colour scheme.

Applying a Colour Scheme to Selected Slides

1. In the Slides pane , select the slides you wish to
change by holding down Control as you click on
each slide.

2. Choose a colour scheme in the task pane.

3. Only the selected slides are affected.

Points to remember when choosing colours

Slide Design

=) Design Templates
La=t Color Schemes
=Yy Animation Schemes

Apply a color scheme:

Title

Title

= Bullet = Bullet

Edit Color Schemes. ..

o The background colour is used for the “canvas” of the slide. All other colours

must show up against it.

. The “Text & Lines” colour must contrast with the background colour so that the

text shows up easily.

o The Shadows colour is generally a darker shade of the background so that it

produces a shadowed effect behind objects.

. The “Title text” colour must also contrast with the background colour because

the slide titles need to stand out.

. The Fill colour is used to fill objects and must contrast with both the
background colour and the colour used for text and lines.

. The primary Accent colour is designed to complement the colours of other

objects in the presentation.

Creating a Custom Colour Scheme

© Senan Solutions
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To create a custom colour scheme, follow these steps below:

1.

2.

6.

Display the Slide Design task pane

Choose Colour Schemes.

Click Edit Colour Schemes at the bottom of the task pane.

Edit Color. Scheme

Standard | Custom |

X

Scheme colors apply
Background
Text and lines

M| shadows

|| Title bext

=] Fills

Ii‘ Accent

I:‘ Accent and hyperlink

I:‘ Accent and Followed hyperlink,

Change Color...

Click the Custom tab

To change one of the eight scheme colours, double-click the corresponding
box, or click the box once and then click Change Colour. The Fill Colour dialog
box displays dozens of colours and several shades of grey from which you can

select a new colour.

Background Color

i Skandard § | Custom ok

Colors: Cancel

e -

Current

il

Select a colour by clicking its pane, and then click OK. If you do not see the

colour you want click the Custom tab shown here:

© Senan Solutions
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Ed

Background Color _ .

Standard | { Cuskom ! m

u |

Red: ~
R 204 2] New
o5 |

areen: -
Blue: _ .

Current

7. You can use the two controls in the upper part of the Custom tab to select a
colour. The large box has a cross hair that identifies the general colour. (the
hue) and the intensity of the hue (the saturation level) when you drag it across
the box. The vertical strip to the right of the box has a triangular marker that
indicates how much black or white is mixed with the colour (the luminance of
the colour) when you drag it up or down the strip. Two colour boxes in the
lower right corner show the new colour and the currently selected colour.

8. When you are satisfied with the new colour click OK to return to the Colour
Scheme dialog box.

Making a Custom Colour Scheme into a Standard Scheme

After you have created a custom colour scheme you may want to add it to the
presentation as a standard scheme. To do this:

1. Display the Slide Design task pane

2. Choose Colour Schemes.

3. Click Edit Colour Schemes at the bottom of the task pane.

4, Click the Custom tab

5. Click Add as Standard Scheme. PowerPoint copies the custom colour

scheme to the Standard Tab.

Note: You cannot save a colour scheme in its own file. The colour scheme is always
part of a template, so you must save the template with a new name in order to
save the revised colour scheme.

PowerPoint’s Colour System

© Senan Solutions Page 9



Masters

Although PowerPoint provides a broad pallet of colours to choose from, it does not
follow the commonly used colour matching systems for selecting and specifying
colours, such as the Pantone system or the Trumatch system. To match a colour, such
as the dominant colour in your company’s logo you must go through the trial-and-error
process of selecting a colour, sending it to your colour printer, examining the output,
and then adjusting the colour in PowerPoint.

The process can be time-consuming because most output devices produce colours that
are lighter or darker than they appear on your screen. In addition, the number of
colours you see on the screen and the precision with which they are displayed depend
on the colour capabilities of your hardware. Even the brightness control on your
monitor affects how a colour looks. When you do find the correct colour, you might
want to make a note of its HSL or RGB numbers so that you can reproduce it later.

Every time you apply a new design template to your slides, a slide master is included in
your presentation. Actually, a pair of masters — because a slide master typically comes
in with a related title master.

Slide Design *

=l Design Templates

[}
(1T
o 1}

] 2

Apply a design template:

Available For Use

[r——

1. Your Design Template
2. The Slide Master and Title Master, containing the styles, layout and colours for
your presentation.

Opening the Title Master or Slide Master

Before you can edit either of the Masters, they must be displayed on the screen.
To display the Title Master,
1. Make sure that a title slide is displayed

2. Hold down the Shift key and click the Normal view button at the bottom left of your
screen. You can also choose Master, and then Title Master from the View menu.
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& Microsoft PowarPoint - [New Intro Exercise. ppt]
E Eie Edt Miew [nsert Format  Tools  SidsShow  Window  Help

N EE RS TE S B 0 o T sl o @

 rial -1 -/ B I U §|= | A 4 | A - | S Desion  jNew Slide Master | = !

4‘ 5 2 [RERRENRRRE: RSN TR RN SN SRR RURT: ENERRRY: 12 ! Slide Design - %
@ ﬁ—'

E 4 ®| A

= Design Templates

L = [z Color Schemes

¢ 2 [k Animation Schemes

2 e b bl & ) G T3 | oss master vien Apply a design template:

+ 2 2

= &

Recently Used

& Click to edit Master subtitle style fivafltle For U

Bisie
z

Click to edit Master title style

Title Area For Autolayout

Subtitle Area For Autolayouts |

 datetimes : B <footers : |
H Date Area! i Footer Area g Humber Area

=
Soraw | g || Adoshapes - N w [ O A Al 52 Ig'ﬁﬁ'é'fﬁﬁ F] Iil
Title Master Default Desian ==

Title Master

Note: If PowerPoint will not display the Title Master, even though a title slide is active,
choose the Insert New Title Master button i on the Slide Master View
toolbar.

To display the Slide Master first make sure that a slide other than the title slide is
displayed then hold down the Shift key and click the Normal View button or choose
Master and then Slide Master from the View Menu.

B Microsoft PowerPoint - [New Intro Exercise. ppt]

i) Fle Edt Vew [nset Fomat  Tools  SideShow  Window  Help

HRR=A" NEW =TI REN e A SN W AR - @
e 4= 4

i arial 218 =B I U 8 |E[==]:=:=]A o e Slide Master ' =

2D B 2 D 2 e B B D 20 e o =
("I@I'ﬂ

Apply slide layout:

Slide Master Yiew

) 3 ) © G ] | Cose Master view

: Click to edit Master title style
i - Click to edit Master text styles

— Second level
+ Third level
— Fourth level
» Fifth level

Text Layouts

Content Layouts

HH (==
i) e
EiES]
BEAEE
Text and Content Layouts

[] Shows when inserting new siides

Ghject Ares for AutoLayaut

dootar,

| «tatentimes

. ES
Footer Area’ i Nurber Area |

Date Area’

==
ibran- ;|| agoshapes N O M At @El2-4-A-S55 4 ﬁ!
Slide Master Default Design g

Slide Master

Editing the Title Master or Slide Master
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The title master and the slide master are the other elements you can modify in the

presentation.

Changes you make to the Title Master affect only the slides that you add using the Title
Slide Layout; changes you make to the Slide Master affect all the other slides in a

presentation. Both masters contain:

. A background colour that can be shaded

A scheme of fonts and text formatting for the slide titles and bulleted text
An optional group of graphic objects placed on the background and

arranged to form a design.

The Title Master and the Slide Master give the presentation an overall look, by

providing the background and the design of the text, as well as saving you the tedium

of having to format each slide individually.

Formatting the Masters

Any changes made to the formats of the Master Slides will affect every other slide in
the presentation. Changes made to the Title Master affect only the title slide; changes
made to the Slide Master are applied to all other slides in the presentation.

If you wish to change the font of the Title Placeholder, select the text within the

placeholder and make the required changes. Change back to slide view by choosing
the Normal view button at the bottom left hand corner and you will see that the change

has been made to every slide.

Bullets through out a presentation should be standardised. Instead of changing the
bullet on each slide you create, change the bullet on the Slide Master and that change

will be applied to every slide.

Using the Masters offers you quick, consistent formatting across the entire

presentation.

Altering the Custom Background

Although the colour scheme supplies a background for a presentation you can modify
the background colour when you change the slide background for the master. You can

apply shading, patterns, textures and even insert
pictures into the background.

Applying Shading, Patterns and Textures

To apply shading, patterns or textures:

1. Choose the Format menu and then choose
Background.
2. Select Fill Effects from the drop down list in

the Background dialog box.

3. Choose Gradient, Texture or Pattern from
the top of the dialog box and choose the
required settings.

Background

Background Fill

Title of Slide
+ Bullet text

— il

Apply o All

Apply

Zancel

Aukornatic

| .

Maore Colars, .,

Fill EFfects. ..
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Fill Effects X

Texture || Pattern || Picture

Colars

Cancel
() One calor

() Two colors

O" Preset

Transparency

From:

Ta:

shading skyles ‘ariants
) Hatizontal

() Yerkical

() Diagonal up

Sample:

I
() Diagonal down

() From cornet I
() From title

Inserting a Picture in the Background

If you prefer you can insert a picture into the background of a master.

Select Fill Effects from the drop-down list in the Background dialog box and then click
the Picture tab at the top. Click the Select Picture button to choose a background
picture. PowerPoint will scale the picture to fit the entire background area of the slide.

You may prefer just to insert a picture onto the Master and not the background of the

master. This way you can control the size and positioning of the picture yourself and
perhaps format the picture as a Watermark.

Inserting a Picture onto the Master as a Watermark

By adding a transparent image to one or all of your slides, you can make a PowerPoint
presentation uniquely your own or clearly identify your presentation sponsor.

A transparent background covers the entire slide. A watermark offers more flexibility, in
that you can change its size and position on the slide. Either one can be applied to
every slide in your presentation or only to slides you choose.

Background Watermark
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Add a transparent background

1. Open a blank PowerPoint presentation, or a completed presentation to which
you want to add a background.

Note If your completed presentation contains master slides, you might not want to
apply the background to the master slides and risk unwanted changes to your
presentation. The alternative is to add the background to one slide at a time.

2. To add a background to all the slides in a blank presentation, point to Master
on the View menu, click Slide Master, and perform the following steps on the
slide master. To add a background to a single slide, simply select a slide and
follow the same steps.

3. Choose the logo or clip art you want to use as a slide background. On the
Insert menu, point to Picture, and then click Clip Art to create a background
from a new picture, or click From File to use a picture you have in your files.

Keep in mind that not all clip art makes an appropriate background. You might have to
experiment a little.

4., Select the logo or clip art you want and insert it in the presentation.
The logo or clip art appears on the slide master, but is not yet transparent.
5. Right-click the logo or clip art on the slide, and then click Format Picture.

6. On the Picture tab, click the arrow next to the Color box, click Washout
(Watermark in PowerPoint 2000), and then click OK.

7. With the logo or clip art still selected, right-click and then click Save as Picture.
Save the image where you can find it. This image can now be used over and
over again and be inserted as a background.

Delete the original image from the slide. You'll replace it with the transparent version
you just prepared and saved.

8. On the Format menu, click Background.

In the Background dialog box, click the arrow in the box under Background fill, click
Fill Effects, and on the Picture tab, click Select Picture.

9. Find and select the picture you formatted as a transparent background, click
Insert, click OK, and then click Apply.

Your transparent image has been added to the master slide as a background, and the
new background will appear on every new slide you add to the presentation. If you
selected a single slide, the background has been added to the slide you selected.
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Add a watermark

1. Open a blank PowerPoint presentation, or a completed presentation to which
you want to add a watermark

Note If your completed presentation contains master slides, you might not want to
apply the watermark to the master slide and risk unwanted changes to your
presentation. The alternative is to add the watermark to your slides one slide at
a time.

2. To add a watermark to all the slides in a blank presentation, point to Master on
the View menu, click Slide Master, and perform the following steps on the
slide master. To add a background to a single slide, simply select a slide and
follow the same steps.

3. Choose the logo or clip art you want to use as a slide background. On the
Insert menu, point to Picture, and then click Clip Art to create a watermark
from a new picture, or click From File to use a picture you have in your files.

Keep in mind that not all clip art makes an appropriate watermark. You might have to
experiment a little.

4. Select the logo or clip art you want and insert it in the presentation.

The logo or clip art appears on the slide master where you will make it
transparent.

5. Select the logo or clip art on the slide, and on the Right-click menu, click
Format Picture.

6. You might want to change the size of the picture as it appears on the slide. On
the Size tab, under Size and rotate, increase or decrease Height.

7. To center your picture on the slide, on the drawing toolbar, click Draw, click
Align and Distribute, and then click Relative to Slide.

8. Click Draw again, click Align or Distribute, and then click Align Center and
Align Middle.
9. On the Picture tab, click the arrow next to the Color box, click Washout

(Watermark in PowerPoint 2000), and then click OK.

At this point, you can either place the watermark in the background of a slide that
already has text, or you can add text to the slide or slides.

10. When you are done editing and repositioning the
watermark and are satisfied with its appearance, to send Larel 8 dajor
the watermark to the back of the slide, right-click it, point to sit amet, adipiscing
Order, and then click Send to Back. Sig Agiam

Note After you send it to the back, you can no longer edit or
reposition the image.
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Adding a Header or Footer

To add a header or footer to your presentation, choose Header and Footer from the
View menu and then click the Slide Tab. The Header and Footer dialog box appears.

Header, and Footer &l

Slide | Mates and Handouts

Include on slide &pply to Al

Dake and time
) Update automatically

| | Cancel

| | | |
(%) Fixed

Slide number
Footer

|Prepared by Sue Cooper |

Presview

Make your choices in the dialog box and when you are satisfied with your choices click
Apply to All to apply the Header or Footer to the entire presentation.

The Slide Master controls the positioning of the elements in the Header/Footer. The
date and time, Footer and slide number areas all appear outside the main bullet
placeholder. You may move, format or delete these placeholders as you wish.

Rename a slide master

1.

2.

On the View menu, point to Master, and then click Slide Master.

In the thumbnails on the left, select the slide master you want to rename.

On the Slide Master View toolbar, click Rename Master .

Rename Master

Master name:

| Renarne
Cancel

Type a new name under Master Name, and then click Rename.

|Oregen Design|
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Prevent a slide master from being deleted

In some cases, Microsoft PowerPoint automatically deletes a slide master when all the
slides that follow that master are deleted, or when another design template is applied to
all the slides that follow that master. You can "preserve" a master so it isn't
automatically deleted in these cases.

1. On the View menu, point to Master, and then click Slide Master.

2. In the thumbnails on the left, select the slide master you want to preserve.
3. On the Slide Master View toolbar, click Preserve Master .

4, If you don't want to preserve the master, just click this button again.
Notes

¢ A master can be deleted manually even when it has a "preserved" setting.

e In a slide-title master pair (slide-master title pair: The slide master and title
master for a given design template that you have applied to a presentation.),
preserving one master automatically preserves the other.

e Aslide master is preserved by default in some cases: when you insert,
copy/paste, or drag a slide master into master view or when you add a new
design template in master view (which automatically inserts a new slide
master).

Note In a slide-title master pair renaming one master automatically renames the
other.

Closing the Slide Master View
When you have completed your redesign of the slide masters click the

| Jlose Master View button on the Slide Master View toolbar.

Saving the Master as a Desigh Template

You can make the Master into a Design Template. This design and colour scheme can
then be used over and over again on all presentations created by yourself or others
that have access to the template.

PowerPoint Design Templates are saved in the Template area (which is determined by

Word) as a .pot file.
g &

Cregen Design e Intro
Template,pot Exercise,ppt

1. Choose Save As from the File menu

3ave a5 LYPe! | Design Template {*, pot) w

2. Change the file type to Design Template

3. Type afilename and click the Save button
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Section 3: Managing Your Presentation

Hiding Slides

Sometimes when preparing a presentation you may wish to have slides available with
background information that may or may not be required during the show. In this case
you may want to make the slides Hidden slides.
To hide one or more slides during a slide show:

1. Select the slides in Slide Sorter view, and

2. Click the Hide Slide button on the Slide Sorter toolbar or choose Hide
Slide from the Slide Show menu.

3. A slash appears through the slide number in Slide Sorter view to indicate that
the slide is hidden.

Crrawing

* § ymuenl Ind e

e ek e
oo xe Hh
FormFani’a

mrem'ul g
=~ SJrrH loote [raaw |

= Thé I T H

THR R A C I B m
—Dra-degu

ot ' oy

Although the hidden slide continues to display in Slide Sorter view, it does not appear
during a slide show unless you call it up.

To show a hidden slide during a slide show

3 1 PowerPoint 2003
. 2 Agend.
1. Move the mouse pointer over the current slide vt
Sllde 4 Bullets
L ]
C h a n S Bullet Levels
2. When the Pop-up button appears in the char E BEE A LR
lower left corner of the slide, click the S;"‘“_“'es
. rawing
bUtton to d|Sp|ay the pop-up menu. &gﬂQ"' 9 & Picture Paints a Thousand Wword
I:reviuus 10 Animated Drawings
3. Choose Go to Slide from the pop-up ) 11 More Drawing Obects ...
menu @0 ko Slide » 12 Tables
13 Charts
. . . . E— 14 Organisation Charts
4. The hidden slide is shown in Brackets. Seen b oa ¢
_ nimating & Running the Show
Help 16 Sound
17 Summary
A quicker way of doing this would be to use Ereshen 18 The nd

the keyboard shortcut. When you are -
showing the current slide just type H on the
keyboard and the hidden slide will show.
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To unhide a slide

1. Select the slide in Slide Sorter view

2. Click the Hide Slide button .

Adding Drill-Down Documents

If you have data in another Windows application that can support an assertion you
have made in a presentation or provide additional information, you can embed the data
as an object on a slide so that it appears as an icon. During the slide show you can
double-click the icon to “drill down” to the information and display the data in its original
form. For example, you can embed a Word document or an Excel spreadsheet as a
drill-down document.

To embed an existing object:
1. Choose Object from the Insert menu,
2. Select Create From File and click the Browse button.
3. Inthe Browse dialog box select the file you want
4. Activate the Display as Icon option

5. Click OK.

The object appears on the current slide as an icon that you can open by double-
clicking.

To use a file in the slide show

K

Action Settings
1. Right click on the icon

Mouse Click. | Maouse Over

2. Click Action Settings nctci;n an dlick
Mone
3. Click Hyperlink to (& Hyperlink to:
?‘-JE::-::I: Slide
4. Choose Other File from the drop- () Run pragram:
down list

5. Select the File, click OK

(") object action:

[JFlay sound:

[T Highlight dick.

a4 ] [ Cancel
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Using Comments

If you are preparing a presentation with colleagues in a Workgroup, you may wish to
use comments to add a temporary annotation for one of your colleagues.

Comments appear like yellow sticky notes on slides. When each comment is created,
PowerPoint adds the name of the person creating the comment automatically.
Comments can be deleted, or easily hidden from view so they do not appear when the
presentation is given.

To add a Comment

1. Choose Comment from the Insert menu.

2. Type your comment after your name, and then click outside the comment when you
have finished. (Notice the Reviewing toolbar appears)

To delete a Comment

To delete a Comment, click on the comment to select it and press Delete.

To hide/show all Comments

If you have not deleted your comments and you are going to run the show the
comments can be hidden.

1. Make sure the Reviewing Toolbar is active, (to switch it on choose the View menu
and then Toolbars and click to switch on Reviewing).

2. Choose the Show/Hide Comments buttonk——.
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Summary Slides

PowerPoint has the ability to quickly and easily create a summary slide from a series of
slides. A summary slide shows the slide titles of other slides as bulleted text items.
You can place a summary slide at the end of a series of slides, or place it before the
series, so it will act as an agenda for the upcoming presentation.

Create a new slide from titles of other slides

1 In Slide Sorter view or Outline, select the slides whose titles you want to use.

gL
2 On the Slide Sorter or Outlining toolbar click Summary Slide L |

A new slide, with bulleted titles from the selected slides, appears in front of the first
selected slide.

| Note: This is a quick and easy way to create an agenda slide.

Hyperlinks

A hyperlink is a command to go to another location. That other location can be another
slide in the same presentation, a slide in another presentation, a file in another
application, or a location on a Web site or intranet. You can even go to an e-mail
address. In other words, you can go anywhere.

You attach a hyperlink to an existing object — text, AutoShapes, a table, a chart or a
picture. Click the hyperlink to go to the specified location. When you attach a hyperlink
to text, PowerPoint underlines the text and displays it in the accent and hyperlink colour
of the presentation’s colour scheme. When you click a text hyperlink, PowerPoint
changes the colour of the text to the accent and followed hyperlink colour of the colour
scheme.

Creating a hyperlink to another slide in your presentation

A common use for hyperlinks is to let you jump around in a complex presentation. To
attach a hyperlink to an object that connects to a location in your current presentation:

1. Select the object to which you want to attach the hyperlink.
2. Choose Insert, Hyperlink to open the Insert Hyperlink dialog box. In the Link to

bar on the left of the dialog box click Place in this Document to display the options
show below:

© Senan Solutions Page 21



Insert Hyperlink

Link ko: Text to display: - |
@ Select a place in this document: Slide previews
| Existing File or 4, Bullets Al
Web Page 5. Bullet Levels L |

&, Changing the Bullst & Fo Jiors Draveing OblBcts. ...

{71 Pictures
Place in This &, Drawing
Docurment 9, A Picture Paints a Thaus.
10, Animated Drawings
GE . Maore Drawing Objects |
Create Mew 12, Tables
Document 13, Charts i

14. Organisation Charts  w L
| *

E-mail Address
| ok ] [ Cancel

3. Choose the slide you wish to go to and click OK.

It is a good idea to now switch to Slide Show view and test the Hyperlink. When you
test the Hyperlink you will end up in the new location. Usually you will then want to
create a complimentary Hyperlink to bring you back to the original location.

Creating a Hyperlink to a slide in another presentation

You can create supporting presentations that contain information that you think you
may need. You can then hyperlink to those presentations as long as they are available
from the computer you are using.

1. Select the text or object you want to attach the hyperlink to. Choose Insert
Hyperlink to open the Insert Hyperlink dialog box.

2. In the Link to Bar choose Existing file or Web Page. Click the File button
under “Browse For”, choose the presentation you want to hyperlink to and
choose OK.

3. Click the Bookmark button to display a list of slides in the presentation you are
hyper linking

Select Place in Document E|

Select an existing place in the document:
=) Slide Titles
1. 5un Seekers
2. Unbeatable Value in the Sun
3, Top Ten Resorts for 1999
4, Mo Slide Title
5. Our Representative
&
7
]
El
1

. Mo Slide Title

. Bonds

. Sales by Reqgion

. Monthly Bond Sales

0. Thank wou For Attending

Cancel

4. Choose the slide you want to go to and choose OK twice to return to your
presentation.
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Creating a Hyperlink to another file or Web Page

You can hyperlink to any other file, even in another application. For example, you can
hyperlink to a Word document, an Excel spreadsheet or an Access database. Hyper
linking to another file or Web page is similar to hyper linking to another slide in a
presentation.

1.

2.

Select the text or object you want to attach the hyperlink to.

Choose Insert Hyperlink to open the Insert Hyperlink dialog box.

In the Link to Bar choose existing file or Web Page.

Either click the File button under “Browse For”, choose the file you want to

hyperlink to and choose OK or type in the URL of the Web Site you want to go
to in the “Type File or Web name page” dialog box and then choose OK.

Creating an e-mail from a slide

You may have seen Web sites that let you instantly e-mail the sponsoring company.
You click an image on the Web page, and your e-mail software opens with the correct
e-mail address already in the message dialog box. You can do the same on a
PowerPoint page. You would use this technique for self-running presentations when
you want potential customers or others viewers to e-mail you with questions or for
further information.

1.

2.

3.

Select any object on a slide.
Choose Insert Hyperlink.

In the Insert Hyperlink dialog box choose E-mail address from the Link To bar.
You see the dialog box show below:

Link ko: Text to display: |Send an Email to Sue Cooper at Oregen
=) E-mail address:
Existing Fil af | |mailto: sue.cooper@oegentraining. com
Web Page
Subject:
]
Place in This | Recently used e-mail addresses:
Dacurnent mailto: Jayne@ijaynewilings,co,uk
Zreake Mew
Document
E-mail Address
[ ok ] [ Cancel ]

In the E-mail Address text box, type the e-mail address you want the e-mail to
go to. In the Subject box type a subject and click OK.
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Editing Hyperlinks

To edit a hyperlink, right click it in Slide View and choose Insert, Hyperlink.
PowerPoint opens the Hyperlink dialog box which is the same as the Insert Hyperlink
dialog box. Make any desired changes and choose OK.

Using Action Buttons

Action buttons are graphics on a slide that control actions you specify. You can use
them to create hyperlinks, to play movies or sounds, or to open applications. You
would use Action buttons to create hyperlinks in your presentation when you want
navigation in a presentation to be obvious.

Action buttons have the following advantages:

They include graphic symbols that are familiar to users from Web sites for
going back, forward to the first slide and so on. Action buttons are therefore

ideal for self-running presentations.

They often look more professional than graphics you would create yourself.

You can play a sound while executing an action.

You can use action buttons to run movies or play music.

You can use action buttons to run macros or programs.

To add an action button:

Display the slide where you want to place the action button.

Choose Slide Show, Action Buttons. On the submenu shown next, choose
one of the buttons. Each button has a screen tip so that you can tell its

intended purpose.

=
=

To insert a button in the default size,
click the slide. Otherwise drag to the
shape you require.

(7] [l
(2] [=]
[ [©]

PowerPoint opens the Mouse Click tab
of the Action Settings dialog box, with a
suggested hyperlink based on the action
button you inserted.

If necessary, click the Hyperlink To
drop-down list and choose another
option.

Click OK.

Action Settings g]

Mouse Click. | Mouse Over

Action on click
O Mone
(%) Hyperlink ta:

Last Slide Yiewed N

Custom Show, ..
Slide...
LRL...
COther PowerPoint Presentation, ., b

[Jrlay sound:

[ 0K, l [ Cancel
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When you use the Hyperlink To drop-down list, not only can you choose another slide
option, but you have all the options you would have if you attached a hyperlink to an
existing object as explain earlier in this section.

Slide Choose any slide in the presentation by its number
and title.
URL Type a URL

Other PowerPoint Presentation You can locate any other presentation and can then
choose any slide from that presentation.
Other File You can choose any file you have access to.

Custom Shows

Overview

Within a single file, you can create mini-presentations that are tailored for different
audiences. Each presentation file contains a core set of slides, and the Custom Shows
feature keeps track of multiple versions of that presentation, eliminating the need for
additional disk space to store and maintain numerous versions. You simply select the
slides you want to include in each custom show, as well as the order in which you want
to show them to a specific audience. Because PowerPoint tracks the slide identification
of specific slides in a custom show, you can freely reorder slides or add slides to the
core presentation without the fear of ruining any custom shows you defined previously.

Creating a Custom Show

1. Choose Custom Shows from the Slide Show menu.

2. In the Custom Shows dialog box choose New.

3. Enter a name for the Slide Show.

4. Select the slides you want in the custom show and click Add. When all slides

are added click OK and then choose OK to close the Custom Show dialog box.

Define Custom 5how E|

slide show name: | South East Show|

Slides in presentation: Slides in custom show:

1. PowerPoink 200 A

2, hgenda

3, Designs & Masl

4, Bullets +
5. Bullet Lewvels

&, Changing the E &+
(71 Pickures

g, Drawing

9, & Pickure Paint

Cancel

Running a Custom Show

To branch to a custom show during a slide show, click the button at the lower left
corner of the current slide and choose Custom Show from the pop-up menu. Choose
the show name.
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Help
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Creating an Agenda Slide and using Custom Shows

You can create a slide that lists agenda items or the main sections of your
presentation, or that you can use as your home page on the Internet. With an agenda
slide, you can jump to a related section in your presentation and then automatically
return to the agenda slide when you are ready to move on to the next item when you
reach the end of the section.

1 Open the completed presentation you want to add an agenda slide to.

2 Create a custom show for each topic you want on the slide. For information
about creating custom shows, see above.

3 In slide sorter or outline view, select the first slide in each custom show.
To select multiple slides, hold down Control and click the slides you want.
4 On the Slide Sorter or Outlining toolbar, click Summary Slide.

A new slide, with bulleted titles from the selected slides, appears in front
of the first selected slide.

5 Select the new slide, and then switch to slide view.

6 To create a hyperlink from a bulleted item to a custom show, select the bulleted
item, and then click Action Settings on the Slide Show menu.

7 Click Hyperlink to, click Custom Shows, and then select the show you want to
jump to.

To return to the agenda slide after the last slide of the custom show,
select the Show and return check box.

8 Repeat steps 6 and 7 for each bulleted item on the agenda slide.
For managing large presentations and flexibility the Agenda slide show on the previous
page is probably the easiest and most flexible approach.

If you want to move quickly from one part of a presentation to another, don’t forget that
you can also create your own Action Button and use Hyperlinks to skip about.
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Section 4: Creating a Slide Show

Overview
A Slide Show is a way of presenting slides electronically on the computer screen. The
presentation doesn't have to be designed as a slide show. To set up a slide show:
1. Open the presentation that you wish to display as a slide show.
2. From the SLIDE SHOW menu choose Set up Show.
Set Up Show I
Show bype Show slides
(%) Presented by a speaker {full screen) @l
() Browsed by an individual {window) ) From: & | To: e
) Browsed at a kiosk (full screen)
Show options Advance slides
[JLoop continuously until 'Esc’ O Manually
Activate when | —1 [ 5haw without narration () Using timings, if present
there is no [ shaw withaut animation Multiple monitars
Presenter
Pen color: | R i

Petformance

[JUse hardware graphics acceleration

slide show resolution: |[e A ]

3. Choose the slides to include in the show.

4. Choose the method to use to advance the slides.

Manual Advance click the mouse button to
advance to the next slide

Use Slide Timings use the timings you set
using the Transition
command.

5. Set whichever other options are desired.
6. Click on OK.

Presenter's view for slide shows

If you are working with a computer that supports multiple monitors, you can use this
feature during a slide show to view speaker notes, but keep them hidden from your
audience, jump to specific slides out of sequence, keep track of time, and more.

1. Select Slide Show on the menu bar, Multiple monitars

2. Select Setup Show. Display slide shaw on:
IF‘rimarw;.-' Manitor j
™ Show Presenter Yiew:
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Some Guidelines for Slide Shows

When you give a slide show, the content should be centre stage, use the tools such as
animations and transitions to emphasise your points, not draw the audience’s attention
to special effects.

If your audience reads from left to right, you might design your animated slides so that
your points fly in from the left. Then to emphasise a particular point, try bringing it in
from the right. The change will grab the audience’s attention and reinforce your point.

The same principle works with sound. An occasional burst of music or sound during a
transition or animation will focus the audience on the slide show. However, frequent
use of sound effects can draw attention away from your main points.

The pace of your presentation also affects audience response. Going too fast can
exhaust audience members, and going too slow puts them to sleep. You can use
PowerPoint features to rehearse your pace before you give a presentation.

While you rehearse, you can also check your slides visual impact. Too many words or

pictures can distract the audience. If you find yourself using too much text, try turning
one slide into two or three, and then increase the font size.

Adding Transitions, Timings and Sound Effects

A transition refers to the way one slide moves off the screen and the next slide
appears. When you set transitions, you can also set timing - how long you want each
slide to appear on the screen.

Each slide can have only one transition. You can set transitions for slides one at a time
or apply the same transition to a group of slides by first selecting the slide or slides in
Slide Sorter view or on the Slides tab in Normal view. You can then use the Slides
Transitions task pane to apply the transition.

You can also specify the following:

e The transition speed
e The sound of the transition
e The direction of the transition

¢ When the transition takes place
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Adding Transitions
1.

2.

Select the Slide Sorter View

From the toolbar select the Transition button

| zib Transition

Choose a transition effect from the Slide
Transition task pane.

Choose how fast you want the transition to take
place (slow, medium, fast).

Select your choice of sound

Choose how to control when the next slide
appears on the screen, either manually by
clicking with the mouse or automatically by
typing in how many seconds the slide is to be
displayed on the screen.

When you Apply to All Slides it will override any
other transitions set..

Click on OK.

Note:

If you have different transitions for every slide
the presentation becomes confusing. It is better
to have consistency throughout the
presentation.

Standard Animations

You can make a slide show more interesting by animating the text and graphics on
your slides. Common types of animation include the following:

Slide Transition

Apply to selected slides:

Uncover Right

Uncover Up

Uneaver Left-Daown
Uncover Left-Up

Uncover Right-Dawn
ncover Right-Up

Wedge

Wheel Clockwise, 1 Spoke
Wheel Clockwise, 2 Spokes
wWheel Clockwise, 3 Spokes
wWheel Clockwise, 4 Spokes
wWheel Clockwise, 8 Spokes
Wipe Down

Modify transition
Speed: |Fast
Sound: | [Mo Sound]

Advance slide

on mouse click,
[ automatically after

Fs
w

Apply o Al Slides

[I- Platy ] [E Slide Show ]

|:| AukoPreview

You can apply text animations so that the text appears on the screen one

paragraph, word or letter at a time.

If a slide has more than one level of bullet points, you can animate different

levels separately.

You can animate objects, such as shapes.

If an object has text, you can animate the object and the text together or
separately, or you can animate one but not the other.

You can change the order of appearance of text or shapes.

You can animate charts created within PowerPoint or imported from Excel. For
example you can animate each data series in a chart to appear at a different

time.
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There are three section to choose from in Animations;
Subtle, Moderate and Exciting, depending on the mood of
your presentation.

Lz Design

1. Click on the Design button to display
the Slide Design task pane.

2. Click on the third option down — Animation
schemes.

3. Create a slide that includes several bulleted points

in the main text area.

4, From the toolbar in Slide Sorter view select a build
effect of your choice.

Custom Animations

Apply to selected slides:
Flash bulb ~
Highlights
Randaom bars
Wipe
Moderate
Agcend
Descend
Compress
Rise up
Show in reverse
Spin
Unfaold
Zoom
Exciting
Big title
Bounce
Credits A

If you would rather create your own animation scheme, you can use the Custom
Animation command on the Slide Show menu. You must be in Normal View. Custom
Animations include moving multiple objects simultaneously, moving objects along a
path, and sequencing all the effects on the slide. You can add your animation scheme
to each slide individually or, with one click, you can apply it to all the slides in a

presentation. This is called a Build Effect.

Build Effects for Slides

A Build Effect can be used to show just the title on a slide when you run the slide
show, then the subtitle or a picture can appear when you click. It can also make very
effective bullet charts, with each bullet point being introduced separately - each bullet
point can be dimmed or hidden as the next appears on the screen.

Building Custom Animation on a Bullet Slide

1. Ensure that you are in Normal view and click on the slide you wish to Animate.
2. Select the placeholder you wish to effect.
3. Choose Custom Animation from the Slide Show Menu.

4. Click on the Add Effect button S_Add Effect =

5. Choose when you would like the effect to take place and what effect you would

like to happen.

S Entrance 3
F Emphasis 2
¥ Exit b
<= Motion Paths »
6. Click the Play button I > Flay I at the bottom of the task pane to view your
effect.

© Senan Solutions

Page 30



Effect Options

For more sophisticated effects, use the Effect " s
Option dialogue box.: D13 Text2i.. o
1%

. . . , Start On Click
In the Custom Animation task pane, click an item

and click the down arrow that appears to the item’s Skart: With Previous
right, and click Effect Options. Ol Start After Previous

£

This options in this dialogue box change depending Effect Options. ..
on the Object you are animating and the Animation
Effect that you have chosen. The animation chosen
below was Fly in Hide Advanced Timeline

Fly In 3

Timing. ..

Remowve

Effect | Timing | Text Animation
Sektings
Direction: |Fr0m Biattam e |
[ Ismooth start [Ismooth end
Enhancements
Sound: |[ND Sound] w | \E
After animation: |Don't Dirn w |
Animake texk: |.°.|| at once w |
=]

Timing Options
Fly In X
Effect | Tirning |Text Animation

sart: | v |
Delay: seconds

Speed: | 0.5 seconds (Yery Fast) |« |

Repeat: | {none) v |

[ rewind when dane playing

oK l ’ Cancel

Start the animation by clicking On a mouse click, at the same time as the previous
object, or a number of seconds after the previous object.

To start the animation automatically, enter the number of seconds you want to elapse
between the previous animation and the current one.
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Animate text and objects

Fly In

Effect | Timing | Text Animation |

e Y=l Eiv 1st level paragraphs
[ Automatically after I:l

[Jin reverse order

(%)

[ oK ] [ Cancel ]

Bulleted slides can appear on the slide all at once, one level at a time or each level with
associated levels.

They can appear on a click or a number of seconds after each other.

Animating Charts

By defaults when you animate a chart it effects the entire object as one. However you
can also animate elements of a chart.

1. Select the chart you want to animate.

2. On the Slide Show menu, click Custom Animation

3. Click on the Add Effect bution 220 Add Effect 7]

4. Select Entrance and only choose one of the options with a green star — that is
the first 4 options.

5. Select the effect in the task pane and click the down arrow that appears to the

item’s right, and choose Effect Options.

6. Choose the Chart Animation tab.

Effect || Timing | Chart Animation

Group chark: |By element in series v

[] anirnate g|As one ohjeck
h By series

By categor
(B element in series
By element in category

I oK, l[ Canicel ]

7. Select how you would like the separate elements of the chart to appear.
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Insert a video clip on a slide
Video Clips and Sound can come from a number of areas.

e Movies and sound installed with PowerPoint within the Clip Organiser
e Movies or Sound create by you and saved in a file on the computer.
e A CD Audio track or DVD inserted in the CD drive

1. In slide view, display the slide you want to add the video to.
2. On the Insert menu, point to Movies and Sounds.
| Mowies and Sounds » Movie from Clip Organizer ..,
@ Chart... Mawie Fram File. ..
1 Table... Sound from Clip Organizer. .,
Obiject... Sound From File. .
o3| Hyperlink... Chrl+K Play CD Audio Track. ..
‘ o ‘ — Ol Record Sound
3. To insert a video from the Media Gallery, click Movie from Clip Organizer, and

then double-click the video you want.

4, To insert a video from another location, click Movie from File, locate the folder
that contains the video, and then double-click the video you want.

Microsoft Office PowerPoint

-
\14) How do wou wank the movie ko start in the slide show?

| Automatically | l When Clicked ]

5. Decide whether you want the movie to start automatically or when you click the
movie icon.

Note: To change how you start a video for example, by positioning the mouse over
the icon instead of clicking it click Action Settings on the Slide Show menu.

Use Custom Animations, Effect Options to set further effects on the Movie, for
example:

e When to Start

e When to Stop

e Timings

e Volume

e Zoom to Full Screen

e Hide when not playing
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Play Movie

Effect |Timing Mavie Settings

X

Play Movie

Effect | Timing | Movie Settings |

Skart plaving
@F
() From last position

() From time! l:l seconds

Stop playing
(2 0n elick
() After current slide

() After: l:l slides

Flay options

Sound volume;

Display options
[THide while nok plaving
[JZoom to Full screen
Information

Tatal plaving time:  00:20
File: <. \Classic_auto_1.mpeg

Enhancements
Sound: | | ,\E
After animation: |D0n't Dim v|
[ oK l [ Cancel ] I OK l [ Cancel
Inserting a Sound
1. In slide view, display the slide you want to add the video to.
2. On the Insert menu, point to Movies and Sounds.
| Maovies and Sounds » | Movie From Clip Organizer...
[H_h Chart... Mavvie From File, ..
| Table... Sound From Clip Organizer...
Object... Sound From File. .,
=) Hyperlink. .. Chrl+k Flay CD Audio Track...
| o I — ol Record Sound -
- : Clip Art v
. . . ®|®|a
3. To insert a sound from the Media Gallery, click Sound
from Clip Organizer. The Clip Art task Pane will Search for:
appear. | | [ |
Search in:
4. Right-click on a sound and choose Preview |8l collections v|
Resulks should be:
Preview/Properties |Se|ected media file types w |
Marme: ELPHRGOL waw
‘ Type: WaVE Audio File N N s
Click the Play Size: 23K8 -
button to hear Created: 8/14/1998 6:35:29 PM Claps che... Telephone
more than Open with: — iTunes
once i Keywords: T T
communications
hones
ringing Skearn W, Party Horns
rings
soﬁnds EI— @
telecommunications
telephones Insert
E] E E =3 Copy
Caption: Telephone _ _
2 Celete From Clip ©rganizer
Btk 13 Make Available OFfline. ..
File: :\Program Files\Microsoft OFficelMEDIAVCAGCATIMELPHRGOL way _:' Move ko Collection, ..
Catalog: C:YProgram FilesiMicrosoft OFficelMEDIAYCAGCAT IOWCAGCAT L0, MM
Edit Keywards. ..
.
Find Similar Style I
PreviewlProperties
- F
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5. Right-click on an icon in the task pane and choose insert to insert on the slide.

Microsoft Office PowerPoint

‘!f) How do wou wank the sound o skark in the slide shovy

[ automatically | [ When Clicked
6. Decide when the sound should be played.
7. To insert a sound from another location, click Movie from File, locate the

folder that contains the sound, and then double-click the sound/file you want.

Playing a CD Track

1. In slide view, display the slide you want to add the video to.
2. On the Insert menu, point to Movies and Sounds.
| Movies and Sounds » | Movie from Clip Organizer. ..
ﬂ Chart... Mavie from File...
= Table... Sound from Clip Organizer. ..
Object:. . Sound From File...
=) Hyperlink... Chrl Play CD &sudio Track. ..
‘ o ‘ -5 Record Sound
3. Choose Play CD Audio Track
Insert CD Audio E|
Clip selection
Skart at krack: % | time: |00:00 % | seconds
End at track: |1 % | time: |00:00 % | seconds

Flaty options
[JLoop until stopped

Sound walurne;

Display options
[THide sound icon during slide shaw

InFormation

Total plaving time;  00:00
File: [CD Audio]

I K ][ Cancel ]

4. Type the track number that you want to play and set any other options
required.
5. Choose OK.

| Note: Make sure that you remember to insert the CD in the CD drive.

Recording a Sound
To record and hear a sound or comment, you need a sound card, microphone, and
speakers.
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1. Display the slide you want to add a sound or comment to.

2. On the Insert menu, point to Movies and Sounds, and then click Record
Sound.

Record Sound

Mame: |%ecorded Sound

Tatal sound length: 0
[>] = [e]

3. To record the sound or voice comment, click Record .
4, When you are finished recording, click Stop .
5. In the Name box, type a name for the sound, and then click OK.

A sound icon I appears on the slide.

Change the default setting for linking sound files
Sound files can be extremely large and will significantly increase the size of your
presentation. By default sound files are inserted into the presentation. However, you
can reduce the size of your presentation by linking the sound files.

A linked object is created in a file on the hard disk and inserted into a PowerPoint file,
while maintaining a connection between the two files. The linked object in the
presentation can be updated when the sound file is updated.

1. On the Tools menu, click Options, and then click the General tab.
2. Inthe Link sounds with file size greater than box, click the arrows to change the

minimum kilobytes required for sound files to be automatically linked to your
presentation.
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Section 5: Delivering Presentations

Shortcuts to use during the Slide Show

Slide show controls

You can use the following shortcuts while running your slide show in full-screen mode.

To

Press

Advance to the next slide

N, ENTER, or the SPACEBAR (or
click the mouse)

Return to the previous slide

P or BACKSPACE

Go to slide <number> <number>+ENTER
Display a black screen, or return to the slide B
show from a black screen

Display a white screen, or return to the slide W
show from a white screen

Stop or restart an automatic slide show S
End a slide show ESC
Erase on-screen annotations E
Go to next hidden slide H
Set new timings while rehearsing T
Use original timings while rehearsing O
Use mouse-click to advance while M

rehearsing

Return to the first slide

Both mouse buttons for 2 seconds

Change the pointer to a pen

CTRL+P

Change the pen to a pointer CTRL+A
Hide the pointer and button temporarily CTRL+H
Hide the pointer and button always CTRL+L

Display the shortcut menu

SHIFT+F10 (or right-click)

Note:

You can press F1 during a slide show to see a list of controls.
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Annotating Slides

The speaker may like to write or draw (annotate) on slides during a slide show

1 Right-click anywhere on the slide, and then click Pointer Options and choose
Pen.
2 Hold down the mouse button as you write or draw on your slide.

Alternatively the second symbol at the bottom left of the screen is the Pen.
wal

Note Participants in a presentation conference can also use the pen to write and
draw on slides. The annotations are visible to all.

Erase annotations during a slide show

Press the letter E.

Note Annotations not erased while the slide is showing disappear automatically
when you move to another slide.

Change the annotation pen colour during a slide show

Arrow
# Ballpoint Pen B Automatic
& Eelt Tip Pen EUE N
Highlighter
& Hahlig EEEEEEEN
| Ik Color v EEEEEENEE
Eraser IEI u "
[ | [ |

Erase All Ink on Slide

Arrow Qpkions [

P

Click the Pointer Options, point to Ink Color, and then click the colour you want.

Change the annotation pen colour before starting a slide show

1 On the Slide Show menu, click Set Up Show.

2 In the Pen colour box, click the colour you want.
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Speaker Notes

Record minutes

Previous version of PowerPoint had a feature called Meeting Minder. This feature has
disappeared in 2003.

If you don't want to switch to another program during your presentation, but still want to
record participant comments for related slides, you can use the Speaker Notes feature
in PowerPoint. To record comments during your presentation, right-click the slide you
want to add comments to, point to Screen, and then click Speaker Notes. Type the
comments in the box, and click Close. Your comments are recorded in the Notes Pane
of your slide.

Assuming that you have set the Multiple Monitors to Show Presenters View, if you
take notes during a presentation, the Speaker Notes appear only on your screen other
participants see only the slide show.

Rehearse the Slide Show

You can set timings for your slides before you rehearse, or you can set them
automatically while you rehearse. If you set them before you rehearse, you will find it
easiest to work in slide sorter view where you see miniatures of each slide in your
presentation.

Advance slide

You can set the timing for one or more selected
slides by clicking Automatically after on the Slide
Transition task pane, and then entering the number

Automatically after

of seconds you want the slides to appear on the 0008 s
screen.
You can also set a different timing for each slide % GanlglolSiccs
for example, you can have the title slide appear for ,
10 seconds, the second slide for 2 minutes, the third [F Play ] [EI Slide Show ]
for 45 seconds, and so on.
[ ] AutoPreview
To rehearse your timings
1 Click Rehearse Timings on the Slide Show menu.
2 You can use the buttons in the Rehearsal dialog box :

Elapsed time of

current slide
Elapsed time
Rehearsal of Slide show
5 I || 0:00:07 P | o:00s
Advance
Button Restart
Pause Slide
Button
. to pause between slides
. restart a slide
. advance to the next slide.
3 PowerPoint keeps track of how long each slide appears and sets the timing

accordingly. If you display the same slide more than once, the last timing is the
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one PowerPoint records. When you finish, you can accept the timings or you
can try again.

Note: If you know the timing you want for a slide, you can enter it directly in the Slide
Time box of the Rehearsal toolbar

Turning Slide Timings on or off for a presentation

Turning off timings does not delete them; you can turn them back on at any time

without having to recreate them.

1. On the Slide Show menu, click Set Up Show.
2. Do one of the following:
e To turn timings on, under Advance slides, click Using timings, if
present.

e To turn timings off, under Advance slides, click Manually.

Voice Narrations

You might want to add narration to a slide show for any of the following reasons:

For individuals who can't attend a presentation
For self-running slide shows

For gaining access to a slide show on the Internet
For archiving a meeting so presenters can review it later and hear comments

made during the presentation

To record a narration, your computer needs a sound card and a microphone. You can

record a narration before you run a slide show, or you can record it during the

presentation and include audience comments. If you do not want narration throughout
the entire slide show, you can also record separate sounds or comments on selected

slides or objects.

If you decide to change something in the narration you have recorded, you will need to
delete the entire narration and rerecord it. Because voice narration takes precedence
over all other sounds, if you are running a slide show that includes both narration and

other sounds, only the narration will be played.

Record a voice narration

1 On the Slide Show menu, click Record Narration.

Record Marration

Current

Quality:

Tip

recording guality

0 Quality

Disk use: 172 kbysecond Cancel
Free disk space: 67839 ME {on i)
Max record lime: 6720 minutes

Set Microphone Level, .,

Change Quality. ..

Adjust quality settings to achieve desired sound quality and disk usage, Higher
recording guality uses more disk space. Large narrations should be linked For better
performance.

[Clirk narrations in: ~ C:\Exercise Files\PowerPoink Files)
2 First check that your microphone is working correctly and adjust the quality if
needs be.
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3 To insert the narration on your slides as an embedded object and to begin
recording, click OK.

To insert the narration as a linked object, select the Link narrations in check box, and
then click OK to begin recording. If you link the recording is held in another file and is
not stored in the presentation. Narrations can be very large files.

4 Advance through the slide show and add narration as you go.

Microsoft Office PowerPoint

\ll) The narrations have been saved with each slide. Do you want ko save the slide timings as well?

Save | ’ Don't Save ]

5 To save the timings along with the narration, click Save. To save only the
narration, click Don’t Save.

¢
A sound icon appears in the lower-right corner of each slide that has
narration.

Points to Remember

o When you run the slide show, the narration will automatically play with the
show. To run the slide show without narration, click Set Up Show on the Slide
Show menu, and then select the Show without narrations check box.

o Because you can not record and play sounds at the same time, while you are
recording you will not hear other sounds you inserted in your slide show.

Pause or stop voice narration during recording

. During recording, right-click, and then click Pause Recording on the shortcut
menu.

To resume recording, right-click, and then click Resume Recording.
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Kiosk Presentations

You can set up your presentation for viewing in a kiosk situation that is, where people
can go through a presentation by themselves, or where a presentation is self-running
and automatically replays when it reaches the end. You can also add voice narration
so viewers can listen to the presenter’s own words as the presentation runs.

Kiosk Presentations runs the slide show full-screen as a self-running show that restarts
after 5 minutes of inactivity. The audience can advance the slides or click hyperlinks
and action buttons but cannot modify the presentation. When you click this option,
PowerPoint automatically selects the Loop continuously until “Esc” check box.

To Set a Kiosk Presentation

. Click Slide Show on the main menu, click Set Up Show, click the Browsed as
Kiosk option button.
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Section 6: Transporting your Presentation

Package for CD

The Package for CD feature in Microsoft Office PowerPoint 2003 allows you to copy
one or more presentations along with supporting files onto a CD. The Microsoft Office
PowerPoint Viewer is included by default on the CD and will run the packaged
presentations on another computer even if PowerPoint is not installed.

Customizing the package

When you package your presentation, linked files are included automatically, although
you have the option to exclude them. You can also add other files to the presentation
package.

Before you give others a copy of the presentation, it is a good idea to review personal
and hidden information, and decide whether it is appropriate to include. You may want
to remove comments, ink annotations, and markup before you package your
presentation.

The PowerPoint Viewer is packaged with your presentation automatically, but you can
exclude it if you know that the computer you will use to run the CD has PowerPoint
installed, or if you are copying presentations to an archive CD.

By default, the CD is set up to play all presentations automatically in the order you
specify (sometimes referred to as an autorun CD), but you can change this default
setting to automatically play only the first presentation, to automatically display a dialog
box from which people can select the presentations they want to play, or to disable the
automatic features and require people to manually start the CD.

Using Package for CD with Microsoft Windows XP or later

You can also use the following procedure to package one or more presentations into a
folder on your computer or at a network location instead of onto a CD. Instead of
clicking Copy to CD in step 8, click Copy to Folder, and then provide the appropriate
folder information.

1. Open the presentation that you want to package. If you are working with a new
presentation that has not been saved, it is recommended that you save the
presentation.

2. Insert a CD into the CD drive.

3. On the File menu, click Package for CD.

Package for CD @

( Copy presentations to a C0 that will play on computers
‘:Ja running Micrasoft Windows 958 Second Edition or later, even
without PowerPaint,

tame the C0: | S e|a= g

Files to be copied:

e Intra Exercise with sound. ppt Add Files. ..

Linked files and the PowerPoint Viewer are
inchuded by default, To change this, click Options, S Eboc

o) (o=
4. In the Name the CD box, type a name for the CD.
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5. To specify the presentations that you want to include, as well as the play order,
do any of the following:

e To add more presentations or other files that are not included
automatically, click Add Files. Select the files that you want to add,
and then click Add.

e By default, the presentations are set up to run automatically in the
order in which they are listed in the Files to be copied list. To change
the play order, select a presentation, and then click the arrows to move
it to a new position in the list.

Note By default, the presentation that is currently open is already in the Files to be
copied list. Files that are linked to the presentation, such as graphics files, are
included automatically but won't appear in the Files to be copied list. In
addition, the Microsoft Office PowerPoint Viewer 2003 is included by default,
so that you can run the packaged presentation on a computer that does not
have Microsoft PowerPoint installed.

e Toremove a presentation, select it, and then click Remove.
6. To change the default settings, click Options, and then do any of the following:

Options EJ

Include these files

[¥]PowerPoint Yiewer {to play presentations without using PowerPoint i

Select how presentations will play in the viewer:

Play all presentations automatically in the specified order  +

Linked files
[ lEmbedded TrueType fants
{These files will not display in the Files to be copied list)

Help protect the PowerPaoint Files
Password to open each File:

Password to modify each File:

[ [o]4 l[ Cancel ]

e To exclude the PowerPoint Viewer, clear the PowerPoint Viewer
check box.

e To prevent presentations from playing automatically, or to specify a
different automatic play option, click an option in the Select how
presentations will play in the viewer list.

e Toinclude TrueType fonts, select the Embedded TrueType fonts
check box.

e To require a password to open or edit all packaged presentations,
under Help protect the PowerPoint files, enter the password that you
want to use.

When you set passwords in Package for CD, those passwords apply to .ppt, .pot, .pps,
and PowerPoint .mht files that have been converted to .ppt files, in the package. If any
of the files that you are packaging already have passwords assigned, PowerPoint
prompts you either to keep the previously assigned passwords for those files or to
override them. If you choose to override the previously assigned passwords, they will
no longer be accepted for the packaged versions of the files. However, they will still be
accepted for the original versions.

7. Click OK to close the Options dialog box.
8. Click Copy to CD.
9. On completion the following dialogue box will appear
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Microsoft Office PowerPoint

£} \  The files were successfully copied to the D,
py Do ywou wank to copy the same files ko another CO?

Operating system requirements

Copying packaged presentations onto a CD requires Microsoft Windows XP or later. If
you have an earlier operating system, you can use the Package for CD feature to copy
packaged presentations only to a folder on your computer, a network location, or a
floppy disk if you do not include the viewer. After you have packaged the files, you can
use a CD burning program to copy the files to CD.
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Section 7: Precision Drawing

Using the Grid, Guides and Ruler

You can position objects precisely by using the Guides command on the View menu.
When an object gets close to a guide, the object snaps to the guide. To add a guide,
press CTRL while you drag an existing guide. You move a guide by dragging it. If the
grid is on, a guide moves from gridline to gridline and may appear to jump. If you want
a guide to move smoothly, one pixel at a time, hold down ALT as you drag. When an
object is almost in place but needs a nudge, click the object, and then press an arrow
key on the keyboard in the direction you want to nudge the object.

The drawing ruler

You can use the horizontal and vertical rulers to move and align objects precisely. If
the rulers are not displayed, click Ruler on the View menu. When displayed, the rulers
appear in slide and notes page view, at the top and left side of the slide window. When
you move the pointer or a drawing tool, its movement traces on the rulers to show you
precisely where you are on the slide.

The appearance of the ruler changes depending on what you select on the slide.
When you select a picture or an AutoShape, the ruler’s origin is at the centre. When
you select text, its origin is at the left. When you select text inside a text box, the ruler

displays the indent markers and tabs for the text. Each text box has its own ruler and its
own indentation and tab settings.

Measure the precise distance between objects

1 Position a guide where you want to begin measuring.

2 Press SHIFT as you drag the guide to where you want to stop measuring.

| The number you see is the precise distance between the objects. |

Show or hide guides

On the View menu, click Guides.

Visible grid Grid and Guides E]
To make aligning placeholders, shapes,

. f . Snap ko
and pictures easier, you can display a
drawing grid and adjust the spacing of the [¥] Snap ohjects ko grid
gridlines. The guides still remain. ] snap objects ko other objects

Choose Draw on the Drawing toolbar and @tid settings
then Grid and Guides

You can now save your settings as
default. y g |:| Display grid on screen

Spacing; | 0.2 W cm

Guide settings

[ Cisplay drawing guides on screen

[Set as Default] [ (o4 | [ Cancel
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Automatic layout for inserted objects

PowerPoint adjusts the slide layout automatically to accommodate pictures, diagrams,
charts, and other items that you add. When you choose a new slide layout, PowerPoint
can automatically rearrange the existing items on the slide to fit the new layout.

Easy selection of an object in a group

This new feature lets you select a single AutoShape in a group, without
ungrouping. This is useful when you want to make certain types of
formatting changes, for example, changing the colour of a single shape
in a group.

Insert multiple pictures

When you insert pictures from files on your hard disk drive, you can select multiple
pictures and insert them all at once.

Picture compression

If selected, may reduce the file size by applying JPEG compression to high colour
picture, which may result in loss of image quality. If cleared, no changes in the
compression method will be made.

-

. . E . . .
Picture Compression # is available on the Picture toolbar

Picture Rotation

You can rotate and flip any type of image file in a PowerPoint 'D\ °
presentation — including bitmaps.

o dest . ")
Multiple design templates per presentation p (’ S
PowerPoint 2002 supports having more than one design template in
your presentation. This is great when you want to combine several G

presentations into one file, but have each section maintain its distinct look.

Save Background or Selection as Picture
When you create a drawing using the drawing tools in PowerPoint, you can save it as a
picture by right-clicking it. You can also save a texture or picture background from a
slide in the same way, making it easy to reuse these graphic elements.
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Section 8: Customise PowerPoint
Toolbars

Toolbars allow you to organise the commands in PowerPoint the way you want so you
can find and use them quickly. You can easily customise toolbars for example, you can
add and remove menus and buttons, create your own custom toolbars, hide or display
toolbars, and move them. In previous versions of PowerPoint, toolbars contained only
buttons. Now toolbars can contain buttons, menus, or a combination of both.

The menu bar is a special toolbar at the top of the screen that contains menus such as
File, Edit, and View. You can customise the menu bar the same way you customize
any built-in toolbar for example, you can quickly add and remove buttons and menus
on the menu bar, but youcan not hide the menu bar.

A menu displays a list of commands. Some of these commands have images next to
them so you can quickly associate the command with the image. You can make a
command easier to switch to by using the Customise dialog box (Tools menu) to create
a toolbar button for the command.

To Add a Button to the toolbar

1 On the Tools menu, click Customise, and then click the Toolbars tab.
2 Click the Commands tab.
3 To add a button to the toolbar, click a category in the Categories box, and then

drag the command you want from the Commands box to the displayed toolbar.
To add a built-in menu to the toolbar, click Built-in Menus in the Categories box, and

then drag the menu you want from the Commands box to the displayed toolbar.

Move or copy a toolbar button

If moving or copying a toolbar button from one toolbar to another, you must show both
toolbars.

To move a toolbar button, hold down ALT and drag the button to its new location.

To copy a toolbar button, hold down ALT+CTRL and drag the button to its new location.
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Setting Options and Defaults

Click Tools on the main menu, Options

Options
Save Securiby Speling and Style
Wit General Edit Prink
Show
Skarkup Task Pane
lide Layout task pane when inserting new slides
Skatus bar

Werkical ruler
Windows in Taskbar
Slide show
Prompt to keep ink annotations when exiting
Show menu on right mouse click
Show popup koolbar
End with black slide
Default vigw

Dpen all documents using this view

|The view saved in the file L |

[ ok | l Cancel

Click on the tabs at the top and change any options

. Click OK
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